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1 Introduction 

The Mobile Vehicle Activated Sign (MVAS), unlike conventional Vehicle Activated Signs, is 
able to operate without any mains electricity supply or solar electrical supplies. The sign uses 
internal lightweight batteries that can be recharged and then deployed in the sign. 
 
The sign utilises a low power radar detector which provides extended operational lifespan 
when coupled with the lithium ion batteries. The optical solution utilises the traditional Swarco 
lens design providing high intensity operation together with excellent performance in sunlight. 
 
The sign is able to detect oncoming vehicles using its integrated radar detector and the 
speed of the approaching vehicle is displayed to the driver. Preset speed thresholds then 
warn the driver to slow down by displaying the sign message when above the speed 
threshold. The warning display consists of LED elements combined to display warning 
messages.  
 
Depending on the required configuration of the sign when ordering, the sign can be supplied 
able to store up to 6 months of data locally or a mobile data connection can be added to the 
sign allowing data to be accessed remotely via the SWARCO in-station software system 
PGS. 
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2 Description 

The MVAS consists of the following primary components: 
 

2.1 Chassis 

The MVAS chassis is constructed from 3mm aluminium which is powder coated (normally 
black although other colours are available on request). The example below shows a 
switchable 20, 30 or 40mph warning sign to TSRGD diagram 670 with a supplementary LED 
text legend which is displayed when a detection is above the set speed threshold. The front 
face is hinged to allow maintenance access.  
 
 

 
 
 
The chassis is IP55 rated and all cable glanding entry points are protected to maintain this 
rating. Locks are fitted at multiple points to secure the front face of the sign once closed and 
also to ensure the seal rating is maintained in use.  
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2.2 Microwave Radar 

The radar is the vehicle detector which is integrated within the sign front face. The radar is a 
24.2GHz module Doppler detector which detects Doppler shift. As a target approaches the 
radar some of the signal is reflected back at a shifted frequency and the measured difference 
between the transmitted and received frequency is proportional to the speed of the 
approaching vehicle. To save energy the radar module powers up and activates every 
200ms to assess the reflected readings and a tracking algorithm then compares these 
readings to track vehicles in the path of the radar, thus improving accuracy of speed 
readings.  
 
The normal detection range of the radar is 100m although this is conditional on the radar 
reflection so a larger vehicle such as a truck may be detected further than 100m away whilst 
a motorbike or similar small vehicle may be detected at a shorter range. 
 
The radar module is supplied in two variants, standard and data logging. Where data logging 
is provided the radar stores traffic data within its own FLASH memory. The data is stored and 
collected in data bins every 15 minutes and stored as a count in 5 mph speed data bins. 
Each time a vehicle is detected approaching the radar its speed is recorded and sorted into 
these data bins.  
Using this approach allows the sign to store data for up to 6 months, although the data 
packet storage is finite so if the time period is adjusted in the configuration to (for example) 
10mins then the data storage period would be reduced by a third. Care should be taken to 
not make the time periods too large; while this will lengthen the storage period beyond six 
months the count can go above the maximum limit and this means some vehicles will not be 
counted. 
 

2.3 Radar Breakout Module 

The breakout module provides a termination point for connection to the radar plus some 
additional facilities. 

2.3.1 Battery Backup 

When the radar is being used for data logging it maintains a real time clock to timestamp all 
of the traffic data. In the event of a power failure the battery backup uses two CR2477 3V 
1Ah Coin Cell batteries to maintain the real time clock for a period of up to 6 months until 
power is restored. If the real time clock should fail during power failure then the batteries 
should be replaced. During normal operation when the sign is powered the batteries are 
unused. 
 

2.3.2 Engineers Terminal 

The breakout module provides an RS232 connection to communicate with the radar. The 
connection can be used to configure the radar, set the real time clock or to download traffic 
data. Alternatively a Bluetooth module can be fitted to provide a roadside wireless connection 
at a maximum of 30m distance from the sign. When using a remote solution to access the 
sign such as a modem to wirelessly connect to the SWARCO in station, on-site engineer 
access will require the sign to be opened and the modem disconnected before the engineer 
can connect to the radar. 
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2.3.3 Sign Drivers 

The radar produces two driver outputs; these are combined in the breakout board to provide 
the following outputs: 
 

Name Pin Comment 

FLASH1 CONN10 Pin 1 Activates during sign operation at a flash rate of 
60-90 flashes per minute 

FLASH2 CONN10 Pin 2 Activates during sign operation but inverted to 
FLASH1 

RING  CONN10 Pin 3 Activates during sign operation 

SPEED CONN10 Pin 4 Activates during sign operation 

MESSAGE CONN10 Pin 5 Activates during sign operation 

GND CONN10 Pin 7,8,9,10 0V Return 

 
Each output is rated at 24/48VDC at a maximum load of 6W. Although the module is 
powered from 12V the LED supply is connected on the STL003 at CONN3 pin 1, so if this is 
connected to 48V all LED drivers will supply 48VDC. 
 

2.3.4 Photocell 

A photocell is connected to the breakout module STL003 on CONN2 between pins 1 and 2 to 
allow the sign display to dim the sign drivers using PWM. Dimming is used to ensure the sign 
is efficiently powered to suit the ambient conditions. 

2.3.5 Remote Access (option) 

To assist remote access when connected to a mobile data modem, outputs are provided to 
confirm sign operation and to provide an alert when the maintenance door is opened. These 
connections are provided as follows: 
 

Function Connection Operation 

12VDC CONN4 Pin 1 12VDC 

ACTIVE CONN4 Pin 2 Output will go active high to 12V when sign 
triggered  

DOOR OPEN CONN4 Pin 3 Output will go inactive to 0V when door is opened 

GND CONN4 Pin 4 GND 

 
Where the door monitor is used a ‘push to make‘ door switch will need to be connected 
between CONN2 pins 1 and 2. 

2.4 DC DC Inverter 

Operating from a single 12VDC supply it is necessary to provide 24VDC for the LED signal 
emitters. The STL024 converts 10-16VDC to a regulated 48 ± 0.5 VDC at a maximum 
loading of 48W. The inverter provides reverse polarity and overload protection in case of 
mishandling or faults. Connections to the module are as follows: 
 

Connection Function 

CONN P1 Pin 1 12VDC Supply input 

CONN P1 Pin 2 0VDC 

CONN P2 Pin 1 0VDC 

CONN P2 Pin 2 48VDC Output 
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2.5 Battery Power 

The sign is powered from one / two of Lithium Ion 12VDC batteries. Further details of 
batteries operation are provided in section 3.3.  

2.6 LED Emitters 

When the sign face is triggered it illuminates to display a warning message with or without 
flashing ambers. Each pixel of the display is formed from an LED and lens. The combination 
of LED and lens provides optical contrast for the sign and allows the signs to meet standards 
for optical uniformity and distribution of the light across the road surface. 
 
The LED emitters provide a sign display certified to EN12966 with the following 
characteristics: 
 
Beam Width  B3 
Luminance Ratio R3 
Colour   C2 
Luminance   L3 
 
 
Depending on the ambient light conditions the LED emitters need to be more or less bright, 
therefore a photo-cell measures the ambient light conditions on the front face of the sign. The 
radar module then uses PWM to control the intensity of the LEDs to 6 different light levels. 
Using this approach also avoids users seeing excessively bright sign displays in low ambient 
light as well as saving energy where possible. 
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3 Installation 

3.1 Mounting the Sign 

When installing the sign on the recommended hinged posts: 
Remove the padlock, nut and bolt at the pivot point and lower the top half of the post.  
Mount the sign onto the post bracket and lower onto the locating lugs. Ensure the sign is 
lowered completely and attach padlock through the post bracket and sign bracket ensuring 
the sign is secure. 
Raise the post back to the vertical position, re-attach the padlock, nut and bolt ensuring the 
post is secure. 
Ensure the sign is facing the centre of the approaching lane at 80-90m. 
 
When installing on an existing post: 
Attach the post bracket using provided clamps ensuring 2.1m mounting height is maintained 
(2.4m for cycle paths). 
Mount the sign onto the post bracket and lower onto the locating lugs (This will require 
ladders or alternative climbing aid). Attach padlock through the post bracket and sign bracket 
ensuring the sign is secure. 
Ensure the sign is facing the centre of the approaching lane at 80-90m. 

3.2 Radar Alignment 

When positioning the sign on the mounting pole it is important to realise that the radar unit is 
mounted parallel to the front surface of the sign. The sign should be targeted to ensure the 
radar is aligned to the centre of the approaching traffic at 60-90m along the carriageway. It 
should be noted that the road from the sign to the 60-90m point needs to be straight. It 
should be noted that any metallic obstructions in the field of view of the radar may affect the 
range and accuracy of detection. 

3.3 Battery Charging 

The MVAS is fitted with one to two lithium ion battery packs, each battery pack is fitted with a 
charge level indicator. Press and hold the charge level indicator button on each battery pack 
to confirm the battery state. 3 green LED’s indicates fully charged and red indicates the 
battery is discharged and requires charging.  It is important for safety reasons that lithium ion 
batteries are not over discharged: the battery output will be switched off at 9V battery level 
for this reason. 
 
The battery is rated for discharge over the temperature range rating of the sign -20C to +60C 
however the battery can only be charged over the temperature range 0 to +45C, therefore do 
not attempt to charge the battery outside this temperature range. Do not attempt to charge 
the battery while the sign is in use. 
 
The batteries are rated for 300 charge / discharge cycles if the sign is operating for a 
maximum of one month then the sign has a maximum battery life of 25 years. 
 
When charging it is important that the batteries are removed from the sign, a mains 230V 
charger is supplied with the sign as well as a 12V cigar lighter charger. It is important to only 
use the chargers supplied with the sign to avoid damage to the batteries and avoid any risk 
of damage to the battery. 
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The battery fuel gauge can be used to identify the charge remaining in the battery. Once the 
battery is off load for 2 minutes or more press the fuel gauge button and read the LED 
pattern as follows: 
 

• No Lights  Empty  Recharge within 12 hours 

• 1 Red Light  <10% Full Battery will switch off to prevent over discharge 

• 2 Red Lights  10-20% Full Recharge ASAP 

• 1 Green & 2 Red 20%-50% Full 

• 2 Green & 2 Red 50-75% Full 

• 3 Green & 2 Red 75-100% Full 
 
WARNING: ONCE THE BATTERY IS FULLY CHARGED DISCONNECT FROM THE 
CHARGER DISCONNECT THE CHARGER FROM THE MAINS SUPPLY. DO NOT LEAVE 
THE BATTERY CONNECTED TO THE CHARGER FOR LONG PERIODS 
 
NOTE: ENSURE WHEN THE SIGN IS FIRST SUPPLIED THE BATTERIES ARE FULLY 
CHARGED FROM THE MAINS SUPPLY USING THE CHARGER PROVIDED. 
 
The batteries are rated for 300 charge / discharge cycles if the sign rated to operate for a 
maximum of one month then the sign has a maximum battery life of 25 years. 
 

3.4 Configuration 

The MVAS can be purchased in two pre-built configurations: 

3.4.1 10 / 20 / 30 mph 

The MVAS display is capable of flashing a speed warning for vehicles exceeding speed limits 
of 10, 20 and 30 mph speed limits. The sign has been pre-configured to support all of these 
speed limits.  
 
To convert the sign to operate in each mode open the enclosure and move the rotary switch 
to the 10, 20 or 30 position, then close and lock the enclosure. The radar trigger speed will 
be set accordingly: 
 

Mode Sign Trigger Speed 

10 11 mph 

20 22 mph 

30 33 mph 

 
As an example if the sign is set to 20 mode when vehicles are detected approaching the sign 
above 22mph the sign will be triggered. These trigger thresholds can be adjusted in the radar 
software configuration. 

3.4.2 20 / 30 / 40 mph 

The MVAS display is capable of flashing a speed warning for vehicles exceeding speed limits 
of 20, 30 and 40 mph speed limits. The sign has been pre-configured to support all of these 
speed limits.  
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To convert the sign to operate in each mode open the enclosure and move the rotary switch 
to the 20, 30 or 40 position, then close and lock the enclosure. The radar trigger speed will 
be set accordingly: 
 

Mode Sign Trigger Speed 

20 22 mph 

30 33 mph 

40 44 mph 

 
As an example if the sign is set to 30 mode when vehicles are detected approaching the sign 
above 33mph the sign will be triggered. These trigger thresholds can be adjusted in the radar 
software configuration. 

3.5 Testing 

Once the sign is installed and configured its operation needs to be verified. Look for vehicles 
travelling away from the radar with no oncoming traffic and confirm the radar is not triggered. 
Now with oncoming only traffic confirm the vehicles (cars only) are detected at 70m+ 
triggering the sign. Please note larger vehicles such as Lorries will be detected at greater 
distances and motorcycles at shorter distances due to the relative size of the radar reflection. 
Up-hill and down-hill locations will also affect the detection range. 
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4 Connecting to the MVAS  

The MVAS is fitted with a Bluetooth adapter to provide remote configuration and monitoring 
of the radar. The device is capable of a data connection speed of 115,200 baud with a 
maximum range of 40m. Please note to meet this range will require a laptop or personal 
computer fitted with a class 1 Bluetooth adapter. 
 
Before accessing the radar ensure the Bluetooth on the PC is paired to the Houston Radar 

Dongle. Double clicking on Bluetooth icon on the taskbar will bring up the display below: 

  

Click Add to add a new device and you should get screen similar to below: 

 

 Ensure the `My device is set up and ready to be found` Checkbox is selected, power is 

applied to the MVAS and select Next> 
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 The Radar HR dongle should be displayed in a window, select the device and then select 

next, this should bring up the following window: 

 

 Select the `Use the passkey found in the documentation `option and enter the passkey 

1234.  

Select Next> 

The device should be assigned serial ports by Windows, as illustrated below: 

 

 At the Radar stats Analyser software go to the file menu and select Connect to Radar> 

The following window will now be displayed: 
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Use to set radar clock to 
computer clock 

 
 

Now select the Connect to Radar button and the application will make a communications 
connection to the radar. 
 
Once complete at the main menu Connection ensure Sync Radar Clock to Computer is used 
to ensure the radar on board clock is at the correct time. 
 

 
 
Once the clock is synchronised the radar will use the clock to time stamp all traffic data held 
within the radar. A battery backup facility maintains the clock for up to 3 months when the 
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main supply batteries are removed. If traffic data is later retrieved without the correct 
timestamp it means the clock has not been set. 
 

4.1 SmartPhone Android Connection via Bluetooth 

The Houston Radar app is only available for the Android devices.   
  

The Houston Radar app is compatible with Android OS 4.0.3 (Ice Cream Sandwich) to 6.0+ 
(Marshmallow).  

  

The app will work on smartphones and tablets.  
 

4.1.1 How to Download the App 

 1. Go to Play Store      2. Search: Houston Radar LLC  

 

  
3

. 

  Click Install         4

. 

  Click Open 

OpenOpen
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4.1.2 How to Connect to the Radar 

 

 1. Click “Bluetooth Scan”      2. Pick your radar  

 

Please Note:  

  

• The scan and connection are  

required to be done only once per 
radar.  

  

• The ID shown is listed on a sticker 

on the device (Bluetooth Dongle).  

  

• The "Remote Radar" is for  

making connections over the Internet if 
the device is on the Internet (with either 
an internal modem or an external 
modem on the serial port).   

  

  

 
  

 
 
 

        
    

    

3 . Click “Pair”   
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4.1.3 How to Set a Meaningful Name for Your Connection 

 

 1. Click on your radar’s drop down menu    2. Click “Settings”   

          
  

 3. Type in your meaningful name      4. The name will appear for that unit  

            

  

and  click   “Ok”   

mailto:office.uk@swarco.com
http://www.swarco.com/


   
 
 
   
   

SWARCO TRAFFIC Ltd. 
7 Mercury Rd, Gallowfields Trading Estate, Richmond, North Yorkshire DL10 4TQ, GB Registration: 7061489 
T. +44-1748 824624, E. office.stl@swarco.com, www.swarco.com/stl 19/50 

4.1.4 How to Download the Data Using One-Tap Operations  

Setting up Play One-Tap Operations: You can set up one tap operation to achieve multiple 
actions. This includes making the connection, downloading data, syncing clock, erasing data 
and sharing the downloaded file. One time configuration is required as described below.    
 
 1. Click on the drop down menu      2. Click settings  

                 
    

3. Setting up your default email:       4. Type in your email address and   

    Click on “Default Email Address”         click “Ok”  

                       
  

5. Scroll down and check: Download        
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4.1.5 Play One-Tap Operations 

Operations to perform: Connect, Download Radar Data, Synchronize Radar Time, Share 
Radar Data and Disconnect   
 

 

     6. Data, Sync Radar Time,  and  Share Data   

  

We recommend  

yo u select Erase  

Data so that you  

don’t save old  
data each time.   
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6. The first time you download data                  8. Installed and available options are  

 this screen will come up asking how        shown in a pop-up  

 
  

9. After you Save to Google Drive,     10. After you have Saved to 
Google the app will make an icon that you                  Drive, this will 
come up for future  can easily click and save                     One-Tap 
Operations. Click “Save”  

you want to share           
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Please Note:   
The available sharing options depend on the application installed on your phone or 
tablet and may be different than shown in the guide.   

  

    

 

 

 

 

 

  
  

mailto:office.uk@swarco.com
http://www.swarco.com/


   
 
 
   
   

SWARCO TRAFFIC Ltd. 
7 Mercury Rd, Gallowfields Trading Estate, Richmond, North Yorkshire DL10 4TQ, GB Registration: 7061489 
T. +44-1748 824624, E. office.stl@swarco.com, www.swarco.com/stl 23/50 

4.1.6 Individual Operations  

Can individually Sync Time, Erase Data, and Download Data after you run the One-Tap 
Operations by:  

 
      

    1 . Click on the radar icon   

                                            
  

             Sync Time                        Erase Data                Download Data   

                       

mailto:office.uk@swarco.com
http://www.swarco.com/


   
 
 
   
   

SWARCO TRAFFIC Ltd. 
7 Mercury Rd, Gallowfields Trading Estate, Richmond, North Yorkshire DL10 4TQ, GB Registration: 7061489 
T. +44-1748 824624, E. office.stl@swarco.com, www.swarco.com/stl 24/50 

4.1.7 How to Disconnect After Connecting  

 
  

  

  

  

 
 

  

1 .  Click on the “X”       
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5 Data Logging & Retrieval 

Traffic data is logged in the MVAS radar, where the data is stored and collected in data bins 
every 15 minutes and 5 mph. Each time a vehicle is detected approaching the radar whether 
it is above or below the speed limit its speed is recorded and sorted into these data bins. 
Using this approach allows the sign to store data for up to 6 months.  
 
As an example vehicles approach the radar as follows and are sorted into their data bins. 
 
Vehicle detected at 16:21:05 at 32.3mph 
This will be stored in the time bin 16:15:00-16:29:59 speed bin 30-35 mph 
 
Vehicle detected at 16:29:45 at 29.9mph 
This will be stored in the time bin 16:15:00-16:24:59 speed bin 25-30 mph 
 
It should be noted where a speed bin is 15-20 mph it is collecting data for vehicles travelling 
in the range 15.0-19.9 mph. 
 
To retrieve data after the signs has been recording data for some time reconnect the PC with 
Analytical software to the radar unit and then: 
 
 

1) Open an existing project from the File menu or create a new project. Project names are 
usually based on the site name or location. Once the project is selected. 

2) Click ‘File’ then ‘Connect To Radar.’ 
3) ‘Connect to Radar.’  
4) Ensure you see “Radar found on COM (x)” message. The COM port number will 

depend on the PC setup. 
5) Click on OK and the radar is ready. 
6) Click ‘Read Traffic Stats From Radar’ select ‘OK’ 
7) Data will now be uploaded into the project together with the timestamps for the 

beginning and end of the data. 
8) A confirmation box will appear, click ‘OK’ 
9) Once the import is complete a new data entry will be shown in the project file 
10) If applicable select ‘Erase Radar Data’ (if you do not erase the data will be left in the 

radar) 
11) Select ‘OK’. A confirmation box will appear, select ‘OK.’ 

 
The data has now been uploaded on to your laptop and can be checked when back in the 
office away from the sign for processing.  
 

5.1 Data Processing 

 
The MVAS radar analysis software allows data collected from the radar to be processed and 
analysed.  
 
At the “File” menu select Open Existing Stats Project, then select the project name. 
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Connection speed 

Speed of last vehicle 

6 Radar Software Configuration 

The sign is delivered pre-configured however you may need to make adjustments to the 
radar configuration parameters if a different setup of the sign is required. 
 
The sign is configured using the Windows Programming Stats Analyser software. Ensure the 
software is installed on your Windows XP, Vista or Windows 7 PC, then connect through to 
the radar using the in-built Bluetooth adapter. Ensure the radar Bluetooth adapter is paired 
with your computer prior to making a connection.  
 
Now start the Radar Stats Analyser software click on  
 

1) File ->Connect to Radar.. 
2) Now select the  “Connect To Radar.’” button 
3) Ensure you see “Radar found on COM (x)” message the COM port number will depend 

on the PC setup. 
4) Click on OK and the radar is ready for configuration. 

 
 

 
 

Once connected the screen will identify the radar firmware the connection speed and the 
speed of the vehicles passing the sign. 
 
The sign will have been pre-configured before leaving the factory there are 3 default 
configurations used: 
 
001-196 10/20/30 mph warning sign 
001-190 20/30/40 mph warning sign 
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Within the MVAS a single rotary switch allows changing both the displayed speed limit and 
the radar speed thresholds. The speed threshold is the speed above which the sign will flash 
a warning message to approaching drivers. Adjust the switch positions to the desired speed 
threshold. Refer to Sections 2.4.1 and 2.4.2 for the speeds thresholds configuration 
respectively for the 10/20/30 and 20/30/40 standard builds.   
 
If a configuration is changed and you want to return to the default configuration then from the 
radar setup screen select More. 
 

 
 
  
 
Now select the Load Config from File into GUI. At the file menu select one of the default 
configurations: 
 
001-196 10/20/30 mph warning sign 
001-190 20/30/40 mph warning sign 
 
Then select Write to Radar to download the configuration into the radar unit.  
 
Once complete at the main menu Connection ensure Sync Radar Clock to Computer is used 
to ensure the radar on board clock is at the correct time. 
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Use to set radar clock to 
computer clock 

 
 
 
Outside the standard radar configurations further changes can be made as required. 
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Sample Time Records. Counts of 
vehicles in each speed bin are 
recorded over 15 minute periods 
as a default. This can be reduced 
to 1 minute sampling or increased 
to 30 minutes. Reducing the time 
period increases memory used in 
storage. 15 minutes intervals will 
allow 6 months of data to be 
stored (default) while 30 minute 
periods increases data storage to 
12 months 

Vehicle data counts are normally 
stored in 5 mph bins i.e. 25-30, 
30-35 etc. this can be changed to 
3mph bins if required. 

6.1.1 Data logging 

 
If provided data logging can be configured at the Data Logging tab. 
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6.1.2 Hardware & IO Config 

This tab allows the hardware operation of the radar and signs to be configured. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6.1.3 Data Output 

The data output facility is used when a GPRS modem is connected to the sign and vehicle 
detected by the radar are streamed through the serial interface. This facility is not currently 
supported on MVAS. 
 
 
 

Diagnostic facility to check supply 
voltage and temperature. IF 
temperature is not accurate 
Calibration button can be used to 
improve accuracy. 

Configuration of display outputs. Hold time 
ensures display persists for default 2 
seconds after vehicle has passed detection 
zone. Increasing time will reduce battery 
life. Outputs going active low trigger the 
display activity, active high will invert 
operation. PWM is normally enabled this 
means the display is dimmed at night to 
avoid bright light for drivers. Blinking will 
cause the output of the sign to flash. A split 
trigger allows outputs 1 and output 2 to 
operate at different speed thresholds.  

When the supply voltage drops to 
below 9V the radar will go into 
standby mode reducing power 
consumption. Waiting for the 
voltage to return to normal. The 
on board clock status is 
maintained.   

Ensure the rotary switch setup is 
available on the detection tab. 

Default LDR is the photo sensor 
used to control dimming. IF a 
PCB mount version is used this 
should be set to Light sensor chip 

The RS232 interface is normally 
powered down to save power. 
Using cable detect it will power up 
when connected only. Always ON 
will increase power consumption. 
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6.1.4 Detection and Units 

The detection and units tabs allow the radar range and detection settings to be adjusted. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Units selection for the radar 
default mph but can also be set to 
kph, ft per sec and meter per sec. 

The maximum detection range of 
the radar is 100m the normal 
setting is 90% of maximum which 
provides good balance between 
range coverage and detection 
accuracy. Increasing the range to 
greater than 90% reduces 
accuracy of detection.  

Direction is set to incoming to 
detect only vehicles approaching 
the sign only. 

Default is set to help reduce 
spurious data from water droplets 
reflecting radar signal at low 
speeds on branches or when 
snowing. 

Default to fastest is set to pick the 
fastest vehicle in a group to 
trigger the sign rather than the 
largest. In this case in a platoon 
of vehicles the fast car will be 
detected over a slower but 
stronger signal from a lorry. 
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6.1.5 Detection Limits Setup 

This tab provides the settings for the speed thresholds used within the sign. 
 

 
 
 
 
 
 
 
 
To change the speed limits ensure Adjust Limits is selected and then change the Minimum 
Display Speed, Speed Limit and Maximum Display Speed to suit. To ensure limits are correct 
use Check Limits and then use the Test Rotary switch position to simulate operation of the 
rotary switch and the adjustments it makes to the radar. In addition Display Speed Limits 
Table will display a summary of all the switch positions. 
 
 
N.B: Always remember to Write to Radar after making any changes in the 
configuration to ensure changes take effect. 
 
N.B: When using a dual faced sign, remember if switching between 33mph / 44mph to 
also change the power switch from ‘30’ to ’40’ for the relevant message to be 
displayed. 
 
 
 
 
 
 
 

Maximum speeds of a vehicle 
which will trigger the sign to 
operate. 

The minimum display speed and 
speed limit are normally set to the 
speed at which the sign is 
required to trigger. If display 
output 2 is required to operate at 
a different speed threshold or 
flash a message then they would 
be set to different speeds. 

Enable if the rotary switch on the 
radar is being used to set 
different speed thresholds.  

When using the rotary switch 
each position steps the speed 
settings up or down by this speed 
increment i.e. 1mph increments in 
this example.. 

As the minimum and speed limit 
thresholds are set to the same 
value it is important both are 
updated by the rotary switch so 
use Shift all limits.  
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6.1.6 Data Logging & Retrieval 

At the radar configuration menu select: 
 

1) Click File then “connect to Radar” 
2) Connect to Radar 
3) Ensure you see “Radar found on COM (x)” message. The COM port number will 

depend on the PC setup. 
4) Click on OK and the radar is ready. 
5) Click ‘Sync Radar Clock To Computer’ Time and date will adjust to your PC (so ensure 

the PC date and time are correct) 
6) Now select the tab “Data Logging” 
7) Ensure data logging is set to record in 15 min time slots. 
8) Save and Start A New Statistics Record Every (15) Minutes. 
9) Strict rain Filter (Disabled) 
10) Hi Resolution Stats Logging (Disabled) 

 
To retrieve data after the signs has been recording data for some time reconnect the PC with 
Analytical software to the radar unit and then: 
 
 

12) Click ‘File’ then ‘Connect To Radar.’ 
13) ‘Connect to Radar.’  
14) Ensure you see “Radar found on COM (x)” message. The COM port number will 

depend on the PC setup. 
15) Click on OK and the radar is ready. 
16) Click ‘Read Traffic Stats From Radar’ select ‘OK’ 
      (The default save location is ‘C:/My Documents/My Radar Stats/No Project). 
17)  You can change the file name as you please. Select ‘Save. 
18) A confirmation box will appear, click ‘OK’ 
19) If applicable select ‘Erase Radar Data’ 
20) Select ‘OK’. A confirmation box will appear, select ‘OK.’ 
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7 Remote GPRS Connection to PGS In-station (Option) 

A GPRS modem (RM6000) can be optionally fitted into the MVAS sign, this provides a 
remote connection from the Swarco Parking Guidance System (PGS) in station. Using this 
connection the in-station can be used to remotely change the speed threshold of the radar 
and collect vehicle data logged in the MVAS radar. 
 
Please refer to the SWARCO RM6000 User Manual for setup details. 
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8 Analysis of Sign Data Logging 

8.1 Downloading data from The Radar 

 
All data that needs to be analysed must be first downloaded into a project. A project is simply 
a place to organize different sets of data together. 

 
The user is the best judge of how they want to organize their data. Some possibilities are: 
 
1.   Fixed location sign or data taken at various times from the same location. 
If the sign is in a fixed location, or you return to the same location over different periods of 
time of the month or year, you may create a project for that location. Then you can import 
data at different times from the same location into the same project. This will allow you to 
analyse different sets of data from that location together and even run comparison over time 
to see how traffic patterns are changing. 

 
2.   Speed studies at various locations. 
In this case, you may want to create a project per speed study, or by date. There are pros 
and cons to each approach. 

 
Project Per Speed Study: In this case, you may end up with a lot of projects. There is no 
inherent limitation to the number of projects allowed, but projects are created and displayed 
in a single level view and a lot of projects may get difficult to navigate after many studies. 

 
Project per date: You may create a project date named by “year-month”. This will allow easy 
navigation if you track your speed studies by date. 

 
The software allows you to label each individual import of data from the radar. The project 
name and import label is printed on each report and chart. Thus, even if you collect your data 
by “Year-Month” format, you can easily have multiple speed studies in the same project even 
if they are from different sites. 

 
STEP 1: Create (or Open) a project to import your data into 
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STEP 2: Name your project or Open Existing Project 
 
 

 
 
 

 
 

 
Step 3: Import Data From Your Connected Radar. Ensure the project you wish to import is 
selected. Data will be imported into this project. 
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If this is an existing project, previously imported data will be shown here and the new data 
will be imported separately and a summary shown as another line in the table as shown 
below. 
 

 
 

 
Select Data then Import Stats Data From Radar… 
 
 

If you connected to the radar in the section “Connecting to a local radar to retrieve data” or 
“Connecting to a remote radar to retrieve data”, you will now be prompted to save a “.dat” 
file. We suggest that you accept the default path and file name and simply click on “Save” 
button. 

 
All imported data is saved in the .dat file on your computer in addition to being imported into 
the project database. This file may then be emailed to a colleague and/or imported into a 
project. We suggest that you simply accept the suggested filename and click “Save”. The 
.dat file will be placed in a folder with the same name as the project in the “My 
Documents\My Radar Stats” directory. This allows you to find .dat files later. 

 

 
 

 
 

mailto:office.uk@swarco.com
http://www.swarco.com/


   
 
 
   
   

SWARCO TRAFFIC Ltd. 
7 Mercury Rd, Gallowfields Trading Estate, Richmond, North Yorkshire DL10 4TQ, GB Registration: 7061489 
T. +44-1748 824624, E. office.stl@swarco.com, www.swarco.com/stl 38/50 

Once you click Save, the program will download the data from the radar. You will see the 
download progress in the following box. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Once all data has been read from the radar and stored into the .dat file, you will be presented 
with “Import Comment” box. This is the opportunity to label this data import. The label will 
show up in the project data window and will be printed on all reports and graphs. 

 
If you are organizing the data into projects created by year-month, we suggest that you label 
your import by location name and traffic direction (e.g main and dartmouth-NB). If you are 
organizing your projects by location name, we suggest you simply use the traffic direction as 
the import label (e.g. incoming or north bound or NB etc.). 

 
You may also insert a comment to be attached to this import. 
Both the label and comment are easily editable later via the project data window. 
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Click on OK button when you are done with your label and comment. At this point you will 
see a progress bar as the data is being imported into the SQL server. 
 
Once the import is complete, a new entry summary will be shown in the project window. 

 
You have now successfully imported data from the radar into the database project. 

 

8.2 Analysing Data and Generating Reports 

8.2.1 Generating Monthly, Weekly and Daily Counts and Speed Reports 

 
STEP 1: Open the project and select the data set you want to analyse 
Refer to the section 8.1,  Step 3: Import Data From Your Connected Radar to create and 
import data into a project. Once your project is open you have two choices to select your 
data set. 

 
Option 1: Run report over one complete data set (import) 
You would choose this option if this is the only data set you have from this one study or the 
time period of your interest lies completely within this data set and the dataset is from the 
same location. The start/end times of records in a dataset are listed in the summary window 
as shown below. 
 

 
 

 
 
You should not proceed with this option if this data set contains data from different locations 
or for some reason you do not wish to run a combined report over all this data. 
 
If your dataset contains data from more than one location, and you know the start/end date 
for your data from your different locations, you should import the same file multiple times and 
trim the data for each import to correspond to the different traffic studies. 

 
Once you have selected the data set to analyse, simply ensure the Generate Analysis 
Report checkbox is selected and then click on the Analyse button. 
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Option 2: Run report over a specified period of time including multiple data sets 
 
 
 

 
 
 
The software allows you to specify start/end period to run the analysis. Using this option 
automatically includes all data in all import sets in this project that are within the specified 
timeframe. 
 
You may not want to use this option if you have data from different locations in this project. 
This is a great way to run a complete analysis that gets filled out as more and more data is 
available. In this case import all available data (as and when available) into the same project 
and run a user defined date range study across the entire time frame as shown below: 

 
Ensure the User Defined Date Analysis tab is selected before you proceed. 
 
 
After you have selected the filter you want (default or created your own), click the “Analyse 
User Range” button and the reports window will pop up. We will next discuss the report and 
the type of analysis it performs. 
 

8.2.2 Interpreting the Analysis Report 

 
Once you click the Analyse or Analyse User Range button, the program selects the data you 
need analysed, runs an analysis and returns the results in the following window. Interpreting 
the Monthly Counts/Speed Avgs tab: 
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As you can see, the report title bar contains the project name and location and this 
information is also repeated within the report window as well. 

 
All analysis is done on an hourly basis and reported by the day of the week. 
 
For example, if you select the Monthly Counts/Speed Avgs tab, you are presented with an 
option to view the average hourly speeds by hour of day for each day of week. 

 

If you selected 85
th 

percentile speeds for the month of June on this tab, the value in the 1
st 

cell (hour = 0-1, Day = Monday) is the average of the 85
th 

percentile speeds from the 
midnight hour to 1am on all Mondays in June (where there is data). And so on and so forth 
for all the cells. 
 

The Week Day 85
th 

% Avg Speed (last) column contains the average of that row excluding 

the weekends. So the 1
st 

cell in the last column is the average 85
th 

percentile speed during 
the weekday in June for the midnight to 1am time slot. 

 
Similarly, the average speed and counts selector on this tab shows the average of the 
average speeds and average counts for the specified hour for the specified day of the week 
in June. 

 
If data for more than 1 month is available, you can select it on the top right. 

 
Interpreting the Weekly Counts/Speed Averages tab 
Click on the Weekly Counts/Speed Averages tab to show the data by actual week. 
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When viewing counts, the cells in this tab contain actual count data for the selected week by 
hour of the day. 

When viewing average or 85
th 

percentile speeds, the cells contain the average or 85
th

 

percentile speed data for the selected week by hour of day. 

 
If the analysis has more than one week of data available, you may select it on the top right as 
shown below. 
 

 

 
 

 
 
 
Interpreting the Charts:Average Weekly Speeds tab 
Click the Charts:Average Weekly Speeds tab to show a hourly graph of the average 
Weekday speeds by hour for the week selected as shown below. 
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When you select a week on any of the weekly tabs, the selection is maintained when you 
click over to another tab. This way, you can simply select a week (say) on the Weekly 
Counts/Speed Averages tab and then click over to the Charts:Average Weekly Speeds or 
Charts:Average Weekly Volumes tab to examine the data in different views for the same 
week. 
 
The charts also allow you to compare data from multiple weeks to see if traffic patterns are 
changing over time. Click the “Enable Comparison” checkbox and select more or more 
weeks to compare to. To select more than one week, hold down the CTRL key while clicking 
to make your selection. 
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You may also plot the 85
th 

percentile speeds by checking the “Plot 85
th 

Percentile Speeds” 
checkbox found next to the week selector box as shown by the red circle in the image above. 

 
Printing and exporting tables or charts 
All tables or charts may be printed or copied to the “Windows Clipboard” for pasting into 
another document. Select the tab page you wish to print or copy. To print it, click File-
>Print… and to copy click Edit->Copy Graph/Spreadsheet to Clipboard… 
 
Once you copy a graph or a spreadsheet to the Windows clipboard, you may then open 
another application (e.g. Word) and paste it into a document. Graphs are pasted as images 
whereas tables (spreadsheets) are pasted as text data in a Word document and numbers in 
Excel. 
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8.2.3 Exporting Summary Report Data 

 
The software also allows you to export 15, 30 or 60 minute and daily summaries. For this to 
work. Select the Export Data menu. On the menu select the data output required whether 
PDF, Excel or Image file: 
 
 

 
 

 
You may specify a summary time interval of 15, 30 or 60 minutes and pace speed interval to 
be used during the summary export. 
To change these settings please go to the Configuration Menu item.  
You will be presented the following window where you may make your selections. These 
settings are applicable to all projects and may be changed at any time and another analysis 
run with the new settings. 
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8.2.4 Generating Interactive Charts 

 
The stats analyser software has a powerful feature where the user may generate interactive 
charts of raw data and navigate through the entire dataset easily and quickly. This feature 
provides a bird’s eye graphical view of the entire data set. 

 
You may generate interactive graphs via the individual checkboxes circled below. 
 

 
 
 

 

Average Speed Interactive Chart 
The average speed interactive chart plots all the vehicle speeds vs. time. Depending on the 
amount of data being plotted in the selected dataset, the data is automatically aggregated in 
optimal time bins. 
 
For example, in the chart shown above, the entire data contains over four months of data for 
58012 vehicles. This is so much data, that the software has automatically re- aggregated it in 
4 hour intervals. Aggregation level is shown on the left side via selected “4 Hr” radio box as 
well as printed on the y axis. 
The above selection means that the count values (shown as gold circles) and the average 
speeds (shown as blue circles) are count totals and average speeds over 4 hours. 

 
Also from the bird’s eye view it becomes apparent that there is a large gap in the data from 

around the 16
th 

of October through the 7
th 

of November. 

 
There are a few ways to navigate around this data. To examine a smaller time period, click 
the left mount button at the start date you want to examine and then click the left mouse 
button again at the end date. The graph will automatically zoom to this range. 
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Once you zoom in, you can easily click another aggregation period on the left pane and the 
data will redraw with higher resolution (e.g. 30 minute or 15 minute as you choose). 

 
If you want the software to automatically pick the best resolution automatically, select “Auto 
Zoom” on the left pane. Now the software will automatically determine the optimal 
aggregation period based on how much data can be displayed on the screen without too 
much clutter. 
 

As you zoom around in the data, the total number of vehicles in the view is automatically 
recalculated and displayed on the top in the legend area. This is a great way to get vehicle 
totals across different or non-standard time periods. 

 
 
Total Counts (Volume) Interactive Chart 
Check the Generate Vehicle Volume Chart checkbox to get an interactive chart of vehicle 
counts (volumes) vs. time. An example is shown below: 
 
 
 

 
 
Selecting the 60 minute aggregation option is a great way to get a bird’s eye view of the 
hourly volume of traffic throughout the dataset. Just as with the average speed chart, this 
chart is completely interactive and you can navigate around in it by mouse clicks, mouse 
scroll wheel and arrow keys. Click on the “Zoom Help” button in the chart area for instant 
help. 
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Histogram Chart 
Click on the Generate Volume by Speed Histogram Chart to generate the following chart. 
This chart plots the number of vehicles in the data set vs. the speed bin they were recorded 
in. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
Percentile Vs. Speed Interactive Chart 

 

Determining the 85
th 

percentile speed of traffic on the road is an important requirement for a 
speed study.   
 

The software allows you to automatically calculate the 85
th 

percentile speed on the road. 
Additionally, it also calculates the speed associated with all percentiles of vehicles from 0 to 
100. This information is plotted as a well known “S” chart. 

 
Check the Generate Percentile Vs. Speed Chart checkbox and click the Analyse button to 
generate the following chart. This chart plots the total percentile counts of vehicles on the 

road traveling at every speed up to the maximum speed in the dataset. The 85
th 

percentile 
speed is also automatically marked by the red crosshairs. For example, in this data set, the 

85
th 

percentile speed is 28mph. You may also click anywhere on the chart and obtain the 
percentile value and speed at that point. 
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9 Specification 

Operating conditions: 
Temperature -15 to +60C 
IP Rating: IP55 
Charging Voltage 230VAC / 12VDC 
 

Radar:  
Fundamental Frequency 24.2GHz (K Band) 
Beam Angle 38° * 45° 
Beam Polarisation Linear 
RF Power 5mW 
Maximum Detection Range 100m 

 
Power:  
 Standby 0.1W 

Maximum Power build specific see sign labelling. 
2* 22 AHr Lithium Ion Battery 
Alternative builds 14Ahr, 14Ahr, 22Ahr providing alternative life between charges. 

 
CE Certification 
 EN12966 Road Vertical Signs – Variable Message Signs 
 
 Uniformity: Pass 
   

Requirement White Red Yellow Blue Green 

Colour C2 C2 C2 C2 C2 

Luminance L3 L3 L3 L3 L3 

Luminance Ratio R3 R3 R3 R3 R3 

Beam Width B3 B3 B3 B3 B3 

 
 Protection: P2 
 Temperature: T1 

Dynamic Snow Pressure: DSL4 
Point Load: PL3 
Wind Loading: WL7 
Temporary Deflection Bending: TDB5  
Partial Action Factor:PAF1 

 
 EN50293 Electromagnetic Compatibility 
 EN50556 Road Traffic Signal Systems - Electrical Safety 
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